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PREFACE 

This document contains the information necessary to install, wire, 
configure, operate, and service 2000 Series Universal Temperature 
Transmitters.* 

The information contained in this document is furnished for customer 
use only.  This information is subject to change without notice. 

 

 

 

 

 

*Transmation 2000 Series is a Pyragon product. 

SNAPTRACK is a registered trademark of Augat, Inc. 

HART is a registered trademark of the HART Communication 
Foundation. 

Windows is a registered trademark of Microsoft Corporation, Inc. 

Transmation Trademark used under license. 

Copyright ©2003 by Pyragon, Inc.  All rights reserved.   
Printed in the United States of America. 
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1. GENERAL 
INFORMATION 

1.1 INTRODUCTION 
 

NOTE 

 

Do not discard this user’s guide.  The information provided in this 
document is essential to safe equipment operation and maintenance.  
To prevent possible personal injury or equipment damage through 
misuse, the procedures outlined in this document should be performed 
by qualified service personnel. 

 

This document describes the 2000 Series Universal Temperature 
Transmitters.  The 2000 Series consists of the Model 2500T, Model 
2800T and Model 2900T analog two-wire transmitters, and the Model 
2850T and 2950T digital two-wire transmitters. 

Standard features of the 2000 Series transmitters include isolation, RFI 
protection, a wide ambient temperature range, outstanding accuracy, and 
agency approvals as noted. 

The 2000 Series transmitters combine digital accuracy and unparalleled 
versatility with standard 4 to 20 mA output.  Each unit can 
accommodate eight thermocouple types, 12 RTD types, millivolts, and 
ohms. 

The Model 2500T transmitter is calibrated and configured via any PC 
that supports RS-232.  Simple software screens facilitate all 
configuration and calibration procedures.  In addition, the Model 2950T 
utilizes the HART® protocol to allow remote testing and calibration with 
enhanced accuracy. 

SECTION 
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Configuration and calibration of the Model 2800T, Model 2850T, Model 
2900T, and Model 2950T transmitters is easily accomplished via two 
front pushbuttons, so unit removal or disassembly is eliminated.  All 
calibration/ configuration functions are contained within the transmitter; 
an expensive programming communicator is not required.  The built-in 
digital display provides an indication of inputs, engineering units, zero 
and span ranges, linearization, and burnout as well as error conditions 
and programming prompts. 

A variety of mounting options extend the flexibility of the Series 2000 
transmitters, including surface mount, SNAPTRACK®, DIN rail, or 
NEMA 4X non-metallic multiple unit enclosure. 

1.2 SPECIFICATIONS 
Unless otherwise indicated, all specifications are referred to an ambient 
temperature of 23°C ± 1°C (73°F ± 2°F). 

Input Types: Configurable to any of the services and ranges indicated 
in Table 1.1 

 
Input Span Limits: Any span within range limits 
 
Input Resolution: 
 Temperature: 0.1° 
 mV: 1 µV 
 Ohms: 0.01Ω 
 
Maximum Output Range: 3.7 to 22 mA DC 
 
Calibrated Output Range: 4 to 20 mA DC 
 
Output Resolution: 0.002 mA 
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Table 1.1   Input Types, Range Limits, and Accuracy 
Input Range Limits Digital Accuracy 1 D/A  
Type °C °F °C °F Accuracy 2 

mV -100 to 100 mV 3 ±0.015 mV ±0.035% of span 
Ohms/RTD 2 or 3 
wire 

0 to 1000Ω ±0.35Ω ±0.035% of span 

B T/C (NIST) 250°/1820°C 482°/3308°F ±0.8°C ±1.44°F ±0.035% of span 
E T/C (NIST) -200°/1000°C -328°/1832°F ±0.2°C ±0.36°F ±0.035% of span 
J T/C (NIST) -180°/1200°C -292°/2192°F ±0.3°C ±0.54°F ±0.035% of span 
K T/C (NIST) -180°/1372°C -292°/2501°F ±0.5°C ±0.90°F ±0.035% of span 
N T/C (NIST) 0°/1200°C 32°/2192°F ±0.4°C ±0.72°F ±0.035% of span 
R T/C (NIST) -50°/1768°C -58°/3214°F ±0.6°C ±1.08°F ±0.035% of span 
S T/C (NIST) -50°/1768°C -58°/3214°F ±0.6°C ±1.08°F ±0.035% of span 
T T/C (NIST) -200°/400°C -328°/752°F ±0.2°C ±0.36°F ±0.035% of span 
Platinum (DIN 
43760) 
50Ω, 100Ω, or 200Ω 

-200°/850°C -328°/1562°F ±0.2°C ±0.36°F ±0.035% of span 

Platinum (DIN 
43760) 
500Ω 

-200°/260°C -328°/500°F ±0.2°C ±0.36°F ±0.035% of span 

Platinum (JIS C 
1604) 
100Ω 

-200°/650°C -328°/1202°F ±0.2°C ±0.36°F ±0.035% of span 

Platinum (Burns 
0.003902) 
100Ω or 200Ω 

-200°/650°C -328°/1202°F ±0.2°C ±0.36°F ±0.035% of span 

Platinum (Burns 
0.003902) 
500Ω 

-200°/260°C -328°/500°F ±0.2°C ±0.36°F ±0.035% of span 

Nickel (Bristol’s 7NA) 
110Ω 

-105°/310°C -157°/590°F ±0.2°C ±0.36°F ±0.035% of span 

Nickel (Minco) 
120Ω 

-80°/320°C -112°/608°F ±0.2°C ±0.36°F ±0.035% of span 

Copper (Minco) 
10Ω 

-200°/260°C -328°/500°F ±0.3°C ±0.54°F ±0.035% of span 

Copper (China 
0.00428) 
50Ω 

-50°/150°C -58°/302°F ±0.3°C ±0.54°F ±0.035% of span 

1 Total digital accuracy for thermocouple only: sum of Digital Accuracy ± 0.3°C (cold junction accuracy). 
2 Total analog accuracy is the sum of the Digital Accuracy and the D/A Accuracy. 
3 Range limits for the Model 2800T, 2850T, 2900T, and 2950T are -9.999 to 99.999 mV. 
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RTD Excitation Current: 200 µA typical 
 
Update Rate: Once per second minimum 
 
Input Impedance: T/C or mV: >10 megohms 
 
Common Mode Rejection: >120 dB @ 50/60 Hz 
 
Normal Mode Rejection: >60 dB @ 50/60 Hz 
 
Input/Output Isolation: 500 VAC 
 
Operating Temperature Range/Humidity: -40°C to 85°C (-40°F to 
185°F); 5% to 95% RH non-condensing 
 
Storage Temperature Range: -50°C to 100°C (-58°F to 212°F) 
 
Temperature Effect: 
 T/C: ±0.2 µV/°C ± 0.005% of Input Reading/°C ± CJC 
 mV: ±0.2 µV/°C ± 0.005% of Input Reading/°C 
 Ohms/RTD: ±0.002Ω/°C ± 0.005% of Input Reading/°C 
 CJC (Cold Junction Compensation): 0.005°C/°C 
 
Loop Supply Voltage: 13V + (Load Resistance x 20 mA) minimum, 
48V maximum (30V maximum for Model 2800T and 2900T) 
 
Power Supply Effects: 0.005% of span/volt 
 
Non-Destructive Input: 30 volts peak 
 
RFI Effect: <1% with no abnormal behavior at 10 V/m @ 450 MHz 
 
Stability: 0.1% or 0.1°C, whichever is greater, for six months with 
constant reference conditions 
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NIST Traceability: The calibration of Pyragon DC voltage, current, 
and resistance products are traceable to the National Institute of 
Standards and Technology via calibration standards which have been 
certified by NIST and are subject to a program of periodic recertification 
 
Approvals: The Model 2800T and Model 2900T are approved for use 
as non-incendive for Class I, Division 2, Group A, B, C, and D 
hazardous (classified) indoor locations.  The approval parameters are: 
 

NI /I /2 / ABCD — 100669-104 / A; Nonincendive Field Wiring 
Max Nonincendive Field Wiring Parameters: 

V Max = 30.0 V, I Max = 130 mA, C i =0 µF, L i = 0 µH 
Universal Temperature Transmitter Model 2800T 
 
NI /I /2 / ABCD — 100671-105/A 
Nonincendive Field Wiring Parameters: 

V Max = 30.0 V, I Max = 130 mA, C i =0 µF, L i = 0 µH 
Universal Temperature Transmitter Model 2900T 

 
The Model 2500T-EXP, Model 2800-EXP, Model 2900-EXP, and 
Model 2950T-EXP are approved as explosion proof for Class I, Division 
1, Groups B, C, and D; dust-ignition proof for Class II/III, Division 1, 
Groups E, F, and G hazardous (classified) locations, indoors and 
outdoors (NEMA Type 4).  The approval parameters are: 
 

XP /I /1/ BCD; DIP / II,III /1 /EFG 
Temperature Transmitter Models 2500T-EXP-a, 2800-EXP, 2900-
EXP, and 2950T-EXP 

a = Number of modules (1 or 2) 
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Transmitter Housing: 
Model 2500T: UL-94 polycarbonate 
 
Model 2800T and 2850T: Injection molded, high impact, conductive 
plastic; meets flammability requirements of UL94 V-O, rated for 
continuous service at 85°C (185°F) 
 
Model 2900T and 2950T: Aluminum and injection molded, high 
impact, conductive plastic; meets flammability requirements of 
UL94 V-O, rated for continuous service at 85°C (185°F) 

 
Connectors: 

Model 2500T: Captive screw clamps for 16 AWG conductor 
maximum, one RJ-22 phone jack for configuration 
 
Model 2800T and 2850T: 6-place cage-clamp terminal block with 
non-exposed terminations for 14-24 AWG conductor 
 
Model 2900T and 2950T: 6-place screw-clamp terminal block with 
non-exposed terminations for 12-22 AWG conductor 

 
Transmitter Dimensions (HWD): 

Model 2500T: 76 mm x 23 mm x 112 mm (3” x .9” x 4.4”), not 
including mounting hardware 
 
Model 2800T and 2850T: 81 mm x 45 mm x 97 mm (3.2” x 1.75” x 
3.8”), not including mounting hardware 
 
Model 2900T and 2950T: 81 mm x 71 mm x 66 mm (3.2” x 2.8” x 
2.6”), not including mounting hardware 

 
Weight: 

Model 2500T: 115 gm (4 ounces) 
 
Model 2800T and 2850T: 300 gm (8 ounces) 
 
Model 2900T and 2950T: 300 gm (8 ounces) 
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Mounting: 
Standard: Surface mounting 
Optional:  
 Adapter for SNAPTRACK® 
 Adapter for 32 mm or 35 mm DIN rail 
 Adapter for conduit housing with 89 mm (3.5”) inside diameter 
 

1.3 ACCESSORIES 
Accessories available from Pyragon for use with the 2000 Series 
transmitters are listed according to model in Table 1.2. 

Table 1.2   Accessories 

Accessory Part Number 
Name 2500T 2800T/2850T 2900T 2950T 

Surface Mount Bracket N/A 500148-089 N/A N/A 
Universal Mounting Bracket (Surface 
or SNAPTRACK) 

N/A N/A 100671-210 100671-210 

SNAPTRACK Mounting Adapter 1 N/A 500108-299 100671-210 100671-210 
32 mm DIN Rail Mounting Bracket 2 N/A 100665-651 100671-212 100671-212 
35 mm DIN Rail Mounting Bracket 2 Included 100665-652 100671-212 100671-212 
PC-Based Configuration/ Calibration 
Software (Model 2500T) 

100856-953 N/A N/A N/A 

HART Protocol PC-Based 
Configuration/Calibration Software 
(Model 2950T) 

100857-052 N/A N/A 100857-052 

HART modem 
(Model 2950T) 

100857-205 N/A N/A 100857-205 

NEMA 4X Non-Metallic Multiple Unit 
Enclosure 

See Figure 
2.4 on page 

2-6 

See Figure 
2.4 on page 

2-6 

See Figure 
2.4 on page 

2-6 

See Figure 
2.4 on page 

2-6 
2” Pipe Stand Mounting Kit N/A 759257-254 759257-254 759257-254 

1 SNAPTRACK mounting channel is ordered separately; specify length (P/N 759276-xxx). 
2 DIN rail mounting channel is ordered separately; specify type and length (P/N 759265-xxx). 
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2. INSTALLATION 

2.1 MOUNTING 
A variety of mounting options are available for 2000 Series transmitters.  
The six standard mounting configurations (refer to Table 2.1 below) 
include surface mount, SNAPTRACK, DIN rail (32 mm and 35 mm), 
NEMA 4 explosion-proof conduit housing, or NEMA 4X non-metallic 
multiple unit enclosure.  Special mounting configurations are also 
supported; contact the Factory for details. 

Table 2.1   Mounting Options 

NOTE: Special mounting configurations are also supported; contact the Factory for details. 

Mounting Transmitter Model 
Option 2500T 2800T/2850T 2900T 2950T 

Surface Mount N/A Available Available Available 
SNAPTRACK N/A Available Available Available 
Din Rail (32 mm) N/A Available Available Available 
Din Rail (35 mm) Standard Available Available Available 
NEMA 4 Explosion-Proof Conduit 
Housing 

2500T-EXP* 2800-EXP* 2900-EXP* 2950T-EXP* 

NEMA 4X Non-Metallic Multiple Unit 
Enclosure 

Available Available Available Available 

*-EXP versions include all hardware necessary to mount transmitter in housing. 

SECTION 
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Consult the instructions listed below for the mounting configuration to 
be utilized.  Mounting dimensions are provided in Figure 2.1 (Model 
2500T), Figure 2.2 (Model 2800T and 2850T), Figure 2.3 (Model 2900T 
and 2950T), Figure 2.4 (NEMA 4X Non-Metallic Multiple Unit 
Enclosure), and Figure 2.5 (NEMA 4 Explosion-Proof Conduit Housing 
as used with the –EXP models). 

For best transmitter performance, observe the following: 

• Select a mounting site for the transmitter that is dry, free of dust and 
corrosives, with an ambient temperature within the specified range 
and a mounting surface that is not subject to excessive vibration. 

• Verify that the transmitter power source is free of excessive noise 
and transients. 

2.1.1 Surface Mounting 
Secure the mounting bracket to the designated mounting surface using 
suitable fastening hardware. 

2.1.2 SNAPTRACK® Mounting 
Using suitable fastening hardware, secure the SNAPTRACK mounting 
channel to the designated mounting surface.  Position the transmitter 
mounting bracket between the rails and press firmly until both ends of 
the bracket “snap” into place.  To remove the unit, spread the channel 
rails slightly and tip the transmitter out. 

2.1.3 DIN Rail Mounting 
Using suitable fastening hardware, secure the DIN rail to the designated 
mounting surface.  Insert the DIN rail mounting adapter into the 
mounting bracket, then “snap” the bracket onto the DIN rails. 
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2.1.4 NEMA 4X Non-Metallic Multiple Unit Enclosure 
Mounting 

It is recommended that DIN rail be used to secure a transmitter in the 
housing as instructed in Section 2.1.5.  Alternately, mount the 
transmitter directly to the backplane attached to the rear of the housing 
using suitable fastening hardware. 

2.1.5 NEMA 4 Explosion-Proof Conduit Housing 
Mounting (For Use With –EXP Models) 

To secure a transmitter in a conduit housing, position the transmitter at 
an angle that permits all wiring to be routed unobstructed through both 
ports.  Insert the conduit housing mounting adapter into the mounting 
bracket.  Insert the assembly into the conduit housing and press firmly 
until both edges of the mounting adapter retaining spring snap into 
place.  To remove the transmitter, insert a screwdriver under each edge 
of the retaining spring and “rock” the unit out. 
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Figure 2.1 Model 2500T Mounting Dimensions 

 
 35 mm DIN Rail 

10633 

Figure 2.2 Model 2800T and 2850T Mounting Dimensions 

 
 Surface SNAPTRACK 32 mm DIN Rail 35 mm DIN Rail 

10635 
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Figure 2.3 Model 2900T and 2950T Mounting Dimensions 

 
 Surface SNAPTRACK 
 
 

 
 32 mm DIN Rail 35 mm DIN Rail 

10526 
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Figure 2.4 NEMA 4X Non-Metallic Multiple Unit Enclosure Mounting Dimensions 

 

DIN Rail Mounting 
Part No. Size A B C D E F G 

100669-718 6 x 4 x 4 4.40” 108 mm 2.00” 51 mm 6.75” 171 mm 7.69” 195 mm 4.79” 122 mm 4.88” 124 mm 2.88” 73 mm
100669-719 8 x 6 x 4 6.40” 157 mm 4.00” 102 mm 8.75” 222 mm 9.69” 246 mm 4.79” 122 mm 6.75” 171 mm 4.88” 124 mm
100669-720 8 x 8 x 4 8.40” 213 mm 6.00” 152  mm 8.75” 222 mm 9.69” 246 mm 4.79” 122 mm 6.75” 171 mm 6.88” 175 mm
100669-721 12 x 10 x 6 10.40” 264 mm 8.00” 203 mm 12.75” 324 mm 13.69” 348 mm 6.79” 172 mm 10.75 273 mm 8.88” 226 mm

 

SNAPTRACK Mounting 
Part No. Size A B C D E F G 

100669-728 6 x 4 x 4 4.40” 108 mm 2.00” 51 mm 6.75” 171 mm 7.69” 195 mm 4.79” 122 mm 4.88” 124 mm 2.88” 73 mm
100669-729 8 x 6 x 4 6.40” 157 mm 4.00” 102 mm 8.75” 222 mm 9.69” 246 mm 4.79” 122 mm 6.75” 171 mm 4.88” 124 mm
100669-730 8 x 8 x 4 8.40” 213 mm 6.00” 152  mm 8.75” 222 mm 9.69” 246 mm 4.79” 122 mm 6.75” 171 mm 6.88” 175 mm
100669-731 12 x 10 x 6 10.40” 264 mm 8.00” 203 mm 12.75” 324 mm 13.69” 348 mm 6.79” 172 mm 10.75 273 mm 8.88” 226 mm

 

NOTE: Contact the Factory for mounting density according to model. 

10473 
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Figure 2.5 NEMA 4 Explosion-Proof Conduit Housing Mounting Dimensions (For Use 
With –EXP Models) 

 

10636 
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2.2 ELECTRICAL CONNECTIONS 
Regardless of the mounting configuration employed, the electrical 
connections are basically identical.  Follow the instructions listed below 
to connect the signal and power wiring to the terminal block.  Be sure to 
observe the terminal block labels as illustrated in Figure 2.6 when 
performing the electrical connections. 

1. Consult the connection diagrams (Figure 2.7 through Figure 2.10) 
for information on making the correct electrical connections to the 
terminal block. 

2. Orient the leads according to the output configuration to be used.  
Strip back the insulation 1/4” on each lead. 

3. For Model 2800T/2850T transmitters, perform the following: 

• Insert the supplied white lever into the terminal block.  Apply 
downward pressure on the end of the lever until the clamp 
mechanism opens.  A small screwdriver may be used in place of 
the white lever to actuate the clamp mechanism.  Insert the 
screwdriver into the aperture at the bottom of the terminal block 
and apply pressure inwards until the clamp mechanism opens. 

• Insert the appropriate wire into the terminal block and release the 
lever.  Verify that the clamp mechanism securely grips the bared 
section of the wire. 

For Model 2500T, 2900T, and 2950T transmitters, perform the 
following: 

• Insert the appropriate wire into the proper terminal block 
aperture. 

• Using a small screwdriver, tighten the corresponding terminal 
block screw clamp.  Verify that the clamp mechanism securely 
grips the bared section of the wire. 
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Figure 2.6 Terminal Block Identification 

    10634 

Model 2500T 
 

    10545 

Model 2800T and 2850T 
 

    10525 

Model 2900T/2950T 
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Figure 2.7 Single Loop Connection with Single DC Supply 

 

10471a 

Figure 2.8 Single Loop Connection Powered by Receiver’s Built-in DC Supply 

 

10472a 
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Figure 2.9 Multiple Loop Connection with Single DC Supply 

 

10470a 
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Figure 2.10 RTD Connections (For Rev. 2) 

  10467A 
 

Two-Wire RTD Three-Wire RTD Four-Wire RTD 

Figure 2.11 RTD Connections (Old Style) 

  10467B 
 

Two-Wire RTD Three-Wire RTD Four-Wire RTD 
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3. CONFIGURATION / 
CALIBRATION 

3.1 OVERVIEW 
Three methods of configuring and calibrating the 2000 Series 
transmitters are available: PC-based, pushbutton, or HART protocol.  
The actual method is dependent on the model.  The Model 2500T can be 
configured/calibrated using any personal computer via RS-232.  The 
Model 2800T and 2900T features quick and simple configuration and 
calibration via the front-panel pushbuttons.  The Model 2850T and 
2950T can utilize the HART protocol for increased convenience and 
accuracy. 

To calibrate or configure a transmitter, determine the method to be used 
based on the model, then refer to the appropriate set of instructions.  To 
perform a PC-based configuration or calibration on a Model 2500T, 
refer to Section 3.2.  To configure/calibrate a Model 2800T, 2850T, 
2900T, or 2950T via the front-panel pushbuttons, consult Section 3.3.  
For information on utilizing the HART protocol with a HART modem to 
configure/calibrate a 2850T or 2950T, refer to Section 3.4. 

To ensure optimum transmitter operation, annual calibration is 
recommended. 

3.2 PC-BASED CONFIGURATION/CALIBRATION 
(MODEL 2500T, 2850T, 2950T) 

3.2.1 Overview 
The software configuration programs for the Model 2500T transmitter is 
supplied on two high density 3.5” diskettes.  Two versions of the 
program are provided, one for DOS and one for Windows®. 

SECTION 
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Serial communication between the PC running the configuration 
software and the transmitter is accomplished via RS-232 protocol.  The 
port on the transmitter is a standard RJ-22 plug-in telephone connector. 

Using the configuration software, the following parameters may be set 
on the transmitter: 

• Input Units:  Select millivolts, ohms, °C, or °F.  If °C or °F is 
selected, the input class (sensor type) must also be selected from the 
options provided on the screen. 

• Input Range Values:  Set the lower range value (corresponding to 
4.0 mA output) and the upper range value (corresponding to 20.0 
mA output).  Minimum and maximum limits to these values are 
displayed on the screen for the input units and type selected. 

• Damping:  A time delay (in seconds) to minimize the effect of rapid 
input signal changes. 

• Linearization:  Turn linearization on or off.  When on, the 
transmitter output will be linear with temperature for thermocouple 
and RTD inputs.  When off, the output will be linear with the actual 
input signal value (millivolts or ohms). 

• Burnout Detection:  Enable or disable a transmitter response to 
sensor burnout.  When enabled, select upscale or downscale 
response to burnout.  Burnout detection should be disabled during 
calibration. 

In addition to these parameters, information about the transmitter for 
later reference and display may be stored.  You may enter and store (in 
the transmitter’s memory) its tag and a description.  The transmitter 
hardware version, software version, and serial number are automatically 
displayed when communications are established with your PC. 
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3.2.2 Software Installation 

3.2.2.1 DOS Installation 
To install the DOS-based program to a hard drive, perform the 
following: 

1. Insert diskette #2 into a 3.5” floppy drive. 

2. While operating in DOS, make the floppy drive the active drive. 

3. At the DOS prompt, type “install” and press Enter. 

 The configuration program will then automatically be installed in a 
newly created directory named TRANSMAT\XMITTERS (or 
another directory you specify) on a hard drive you select. 

4. Follow the on-screen instructions to complete the installation. 

5. Once the program is installed, remove the diskette from the floppy 
drive. 

3.2.2.2 Windows 3.11 Installation 
To install the Windows 3.11-based program to a hard drive, perform the 
following: 

1. Start Windows 3.11. 

2. Insert diskette #1 into a 3.5” floppy drive. 

3. From the Program Manager, go to the File menu and select Run. 

4. In the Command Line text box, type “a:\setup”, then click OK. 

 The configuration program will then automatically be installed in a 
newly created directory named TRANSMAT\XMITTERS (or 
another directory you specify) on a hard drive you select. 

5. Follow the on-screen instructions to complete the installation.  When 
instructed, insert diskette #2 into the floppy drive. 

6. Once the program is installed, remove the diskette from the floppy 
drive. 



Transmation 2000 Series Universal Temperature Transmitters 
User’s Guide and Reference Manual 

3-4     CONFIGURATION / CALIBRATION Rev. 0803 

3.2.2.3 Windows 95 Installation 
To install the Windows 95-based program to a hard drive, perform the 
following: 

1. Start Windows 95. 

2. Insert diskette #1 into a 3.5” floppy drive. 

3. Click on Start, then click Run. 

4. In the Command Line text box, type “a:\setup”, then click OK. 

 The configuration program will then automatically be installed in a 
newly created directory named PROGRAM FILES\TRANSMAT\ 
XMITTERS (or another directory you specify) on a hard drive you 
select. 

5. Follow the on-screen instructions to complete the installation.  When 
instructed, insert diskette #2 into the floppy drive. 

6. Once the program is installed, remove the diskette from the floppy 
drive. 

3.2.3 Software Operation 

3.2.3.1 DOS Operation 
To run the software in DOS from the hard drive, perform the following: 

1. Operate your PC in DOS. 

2. Select the TRANSMAT\XMITTERS directory (or the directory you 
specified during software installation). 

3. For the Model 2500T, type “cnfdos”, then press Enter. 
For the Model 2850T and 2950T, type “hartdos”, then press Enter. 
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3.2.3.2 Windows Operation 
To run the software in Windows from the hard drive, perform the 
following: 

1. Start Windows. 

2. Double-click on the TRANSMAT program group icon. 

3. Double-click on the desired program name (CNFWIN for the Model 
2500T; HARTWIN for the Model 2850T and 2950T). 

3.2.4 Configuration 
Follow the procedure described below to configure a Model 2500T 
transmitter. 

NOTE 

 

Prior to configuring a transmitter, configure the communication port of 
your PC to use either Com 1 or Com 2 (the default setting is Com 2).  
The configuration software may be set to respond to either port as 
described in Step 4 below. 

 

1. Using a suitable cable, connect the RS-232 port of the transmitter to 
the serial port of your PC.  For a Model 2850T and 2950T 
transmitter, connect a HART modem as instructed in Section 3.4. 

2. Apply power to the transmitter. 

3. Launch the configuration software.  The Information Display screen 
illustrated in Figure 3.1 on page 3-7 will be generated. 

4. From the Options menu, select Comm. Port.  Use the up and down 
arrow keys to highlight the proper communication port, then press 
Enter. 

5. To verify proper communications, click the ON radio button next to 
the Update Value field.  A numerical process value at the top of the 
Information Display screen will be generated.  If communications 
are not successfully established, make sure that the correct 
communication port is selected (refer to Step 4). 
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6. Begin the transmitter configuration process by clicking the Load 
from Xmtr command button.  The current configuration of the 
transmitter will be displayed.  This configuration may be accepted or 
modified as described below. 

• Enter Tag Information:  When the configuration software is 
started, the cursor defaults to the Tag field.  Enter tag 
information for the transmitter by typing up to nine alphanumeric 
characters. 

• Enter Descriptor Information:  Enter any descriptive 
information for the transmitter by clicking in the Descriptor field 
and typing alphanumeric characters. 

NOTE 

 

The three fields at the right of the tag information fields contain 
information obtained from the transmitter.  This information cannot be 
changed. 

 

• Select the Process Value Units:  Click on the arrow to the right 
of this field to display a drop-down menu of available units.  
Click on the desired unit to select it.  The drop-down menu will 
close and the selected unit will be displayed in the field. 

• Select the Input Class:  When the Process Value Units are °C or 
°F, the Class field just below the Units field becomes active.  
Click on the arrow to the right of this field to display a drop-
down menu of available temperature sensor classes (types).  
Eight thermocouple and 12 RTD types are listed.  Click in the 
scroll bar to the right of the drop-down menu to view all the 
options.  Click on the desired sensor type to select it.  The drop-
down menu will close and the selected class will be displayed in 
the field. 
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Figure 3.1 Configuration Information Display Screen 
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• Set the Range Values:  To set the Lower Range Value (input 
value at 4.0 mA output) and Upper Range Value (input value at 
20.0 mA output), click in the field and type in the value.  As a 
guide, the minimum and maximum values (limits) for the 
selected input are automatically listed to the right of these fields.  
Note that the resolution for each input type is shown in the 
format of these numbers, so entered data should be in the same 
format.  For example, the limit values for a type J thermocouple 
are -180.0° to 1200.0°C.  The values you enter should have the 
same resolution (i.e., 0.1°C). 
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• Set Burnout Detect Action:  In the Windows program, click on 
Upscale or Downscale to enable the desired environment.  In the 
DOS program, click on the arrow to the right of this field to 
display a drop-down menu.  Click Disabled for no input burnout 
protection; click Enabled for burnout protection.  When Enabled 
is selected, a new field appears to the right.  Click on the arrow 
to the right of this field to display the choice of upscale or 
downscale burnout.  Click on the desired detection mode to 
select it.  The drop-down menu will close and the selected option 
will be displayed in the field. 

• Set Linearization:  Click on the arrow to the right of this field to 
display a drop-down menu.  Click Off for output linear to input 
values (mV or ohms); click On for output linear to input 
temperature for thermocouple and RTD inputs.  The drop-down 
menu will close and the selected option will be displayed in the 
field. 

7. When the Information Display screen displays the desired 
transmitter configuration, click the Store to Xmtr command button to 
write the configuration to the transmitter.  The configuration values 
will become effective immediately. 

NOTE 

 

No configuration changes will be saved until the Store to Xmtr 
command button is clicked. 

 

8. The configuration process is now complete. 
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3.2.5 Configuration Setup Backup/Retrieval 

3.2.5.1 Saving Configuration Setups to Disk 
The Windows-based program allows transmitter configuration data to be 
saved to a file on disk.  The data is saved as ASCII text in a comma 
delimited format. 

To save transmitter configuration setup data to a disk file for future use, 
perform the following: 

1. Using a suitable cable, connect the RS-232 port of the transmitter to 
the serial port of your PC. 

2. Launch the configuration software.  The Information Display screen 
illustrated in Figure 3.1 on page 3-7 will be generated. 

3. As required, insert a diskette into the floppy drive. 

4. From the File menu, select Open File to Store. 

5. Enter the destination drive, directory pathname, and file name, then 
press Enter. 

6. Connect the transmitter. 

7. Click on the Load From Xmtr command button. 

8. Click on the Store Next Record command button. 

NOTE 

 

A file may contain configuration setup data for multiple transmitters.  
Repeat Steps 6-8 for each transmitter. 

 

9. From the File menu, select Close File or Exit. 

10. As required, remove the diskette from the floppy drive. 
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3.2.5.2 Retrieving Configuration Setups From Disk 
The Windows-based program allows transmitter configuration setups to 
be retrieved from a data file on disk.  To retrieve the data from disk, 
perform the following: 

1. Using a suitable cable, connect the RS-232 port of the transmitter to 
the serial port of your PC. 

2. Launch the configuration software.  The Information Display screen 
illustrated in Figure 3.1 on page 3-7 will be generated. 

3. As required, insert the diskette containing the proper data file(s) into 
the floppy drive. 

4. From the File menu, select Open File to Load. 

5. Enter the source drive, directory path, and file name, then press 
Enter. 

6. Connect the transmitter. 

7. Click on the Store to Xmtr command button. 

8. If the file contains data for multiple transmitters, perform the 
following: 

a. Click on the Load Next Record command button. 

b. Connect the transmitter. 

c. Click on the Save to Xmtr command button. 

d. Repeat Steps a-c for each transmitter. 

9. From the File menu, select Close File or Exit. 

10. As required, remove the diskette from the floppy drive. 
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3.2.6 Calibration 
Follow the procedures outlined below to calibrate a Model 2500T 
transmitter.  To ensure proper accuracy, perform the configuration 
procedure described in Section 3.2.4 before attempting calibration. 

NOTE 

 

Recalibration is not required after configuration or re-configuration. 

Linearization tables are built into the transmitter.  This linearization 
works best when the calibration procedures specified below are 
followed exactly.  Thermocouple linearization depends on calibration 
of both millivolt and thermocouple, while RTD linearization requires 
ohm calibration.  Any attempt to improve linearity by using the process 
zero and span for calibration will only reduce the accuracy of the 
transmitter. 

 

1. Using a suitable cable, connect the RS-232 port of the transmitter to 
the serial port of your PC. 

2. Apply power to the transmitter. 

3. Launch the configuration software.  The Information Display screen 
illustrated in Figure 3.1 on page 3-7 will be generated. 

4. To verify proper communications, click the ON radio button next to 
the Update Value label.  A numerical process value at the top of the 
Information Display screen will be generated.  If communications 
are not successfully established, make sure that the correct 
communication port is selected (refer to Step 4 in Section 3.2.4). 

5. At the Information Display screen, disable burnout detection. 

6. Begin the transmitter calibration process by clicking the Calibrate 
command button.  The Calibration Menu (illustrated in Figure 3.2 on 
page 3-12) will be generated. 
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Figure 3.2 Calibration Menu 
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7. Four command buttons are located at the bottom of the Calibration 
screen: 

• Cal Date:  Displays the date of the most recent calibration of the 
transmitter. 

• Input Cal:  Displays a screen used to calibrate the input signal 
to the transmitter as described in Section 3.2.6.1. 

• Output Cal:  Displays a screen used to calibrate the output 
signal of the transmitter as described in Section 3.2.6.2. 

• Main Menu:  Closes the Calibration Menu and returns the Main 
Menu. 
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8. As the Warning displayed at the center of the Calibration Menu 
states, calibration will change the transmitter output.  To prevent 
potential control problems, remove the loop from automatic control 
before performing the calibration procedure. 

9. To perform an input or output calibration, refer to the applicable 
procedure described in Section 3.2.6.1 or Section 3.2.6.2. 

3.2.6.1 Input Calibration 
1. Connect a precision input source of suitable accuracy to the 

transmitter input terminals. 

2. Click on Input Cal.  A screen will be displayed that prompts for a 
low input signal, one near to but not necessarily equal to the desired 
zero percent input (corresponding to 4 mA output). 

3. Set the input signal to a value near to the zero percent value.  For 
best results, use an input close to the lower input range limit (see 
Table 1.1 on page 1-3).  An accurate way to measure this value 
external to the transmitter is required. 

4. Enter the externally measured value in the field shown on the screen, 
then click OK. 

5. Set the process input value near to, but not necessarily equal to, the 
desired high level (corresponding to 20 mA output) value.  For best 
results, use an input close to the upper range limit (see Table 1.1 on 
page 1-3). 

6. Enter the externally measured value in the field shown on the screen, 
then click OK. 

7. The transmitter will automatically calibrate its input measurements 
based on these two known input values. 
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3.2.6.2 Output Calibration 
1. Connect the output signal (current loop) to an accurate current 

measuring instrument. 

2. Click on the Output Cal command button.  A screen will be 
displayed that prompts for a low output signal, one near to but not 
necessarily equal to 4 mA. 

3. Enter the externally measured value of this current in the field 
shown on the screen. 

4. Repeat the process for the desired high level (20 mA) output value. 

5. Enter the externally measured value of the output loop current in the 
field shown on the screen. 

6. The transmitter will automatically calibrate its output current based 
on these two known output values. 

7. Exit from this screen to return to the Main Menu. 

3.3 PUSHBUTTON CONFIGURATION/CALIBRATION 
(MODEL 2800T, 2850T, 2900T, 2950T) 

The Model 2800T, 2850T, 2900T, and 2950T transmitters may be easily 
configured and calibrated in the field by simply following the menu 
prompts that appear on the display and pressing the front panel arrow 
keys.  To select (enter) a menu item or store data, press both arrow keys 
simultaneously.  To scroll through available menu items or adjust a 
value, press either arrow key.  A functional flowchart listing the 
available menu options is provided in Figure 3.3 on page 3-16. 

NOTE 

 

Recalibration is not required after configuration or re-configuration. 
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3.3.1 Pushbutton Configuration 
Follow the procedures outlined below to configure a transmitter using 
the front-panel pushbuttons. 

1. Simultaneously press both arrow keys to enter the SETUP mode 
(indicated by the SETUP legend). 

2. Scroll through the menu options until CNF is displayed, then 
simultaneously press both arrow keys. 

3. Scroll through the menu options until UNITS is displayed, then 
simultaneously press both arrow keys. 

4. Scroll through the menu options until the desired unit of measure 
(°F, °C, Ω, M) is displayed, then simultaneously press both arrow 
keys. 

5. Scroll through the menu options until CLASS is displayed, then 
simultaneously press both arrow keys. 

6. Scroll through the menu options until the desired class-of-service is 
displayed, then simultaneously press both arrow keys. 

7. Scroll through the menu options until ZERO is displayed, then 
simultaneously press both arrow keys. 

8. Adjust the displayed zero value as desired, then simultaneously press 
both arrow keys. 

9. Scroll through the menu options until SPAN is displayed, then 
simultaneously press both arrow keys. 

10. Adjust the displayed span value as desired, then simultaneously 
press both arrow keys. 

11. Scroll through the menu options until END is displayed, then 
simultaneously press both arrow keys. 

12. Simultaneously press both arrow keys to reenter the SETUP mode. 

13. Scroll through the menu options until OPT (OPTION) is displayed, 
then simultaneously press both arrow keys. 
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Figure 3.3 Functional Flowchart 
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14. Scroll through the menu options until BURN (BURNOUT) is 
displayed, then simultaneously press both arrow keys. 

15. Scroll until the desired burnout configuration (UP, DN, or OFF) is 
displayed, then simultaneously press both arrow keys.  

NOTE 

 

Burnout must be set to OFF for RTD configurations. 
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16. Scroll through the menu options until LNOUT (LINEARIZED 
OUTPUT) is displayed, then simultaneously press both arrow keys. 

17. Scroll until the desired linearization configuration (ON or OFF) is 
displayed, then simultaneously press both arrow keys.  (NOTE: ON 
= output linear with respect to temperature; OFF = output linear 
with respect to mV or ohm input.) 

18. Scroll through the menu options until PRCNT (PERCENT) is 
displayed, then simultaneously press both arrow keys. 

19. Scroll until the desired percent configuration (ON or OFF) is 
displayed, then simultaneously press both arrow keys.  (NOTE: ON 
= display indicates input as % of span; OFF = display indicates 
input in engineering units.) 

20. Scroll through the menu options until LOCK (LOCKOUT) is 
displayed, then simultaneously press both arrow keys. 

21. Scroll until the desired lockout configuration (ON or OFF) is 
displayed, then simultaneously press both arrow keys.  (NOTE: ON 
= lockout activated; OFF = lockout deactivated.) 

22. Scroll through the menu options until FILT (FILTER) is displayed, 
then simultaneously press both arrow keys. 

23. Press the up or down arrow key until the desired interval (i.e., 0 to 
60 seconds) is displayed, then simultaneously press both arrow keys. 

24. Scroll through the menu options until END is displayed, then 
simultaneously press both arrow keys. 

NOTE 

 

No configuration changes will be saved until END is selected.  If END 
is not selected, the transmitter will revert to the previous configuration 
after 75 seconds of inactivity. 

 

25. When DONE is displayed, the configuration process is complete. 
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3.3.2 Pushbutton Calibration 
Follow the procedures outlined below to calibrate a transmitter using the 
front-panel pushbuttons.  To ensure proper accuracy, perform the 
configuration procedure described in Section 3.3.1 before attempting the 
calibration. 

NOTE 

 

Linearization tables are built into each transmitter.  This linearization 
works best when the calibration procedures specified below are 
followed exactly.  Thermocouple linearization depends on calibration 
of both millivolt and thermocouple, while RTD linearization requires 
ohm calibration.  Any attempt to improve linearity by using the process 
zero and span for calibration will only reduce the accuracy of the 
transmitter. 

 

3.3.2.1 Millivolt Input Calibration 
1. Connect a precision input source of suitable accuracy to the 

transmitter input terminals (a typical calibration connection is 
illustrated in Figure 3.4 on page 3-19). 

2. Simultaneously press both arrow keys to enter the SETUP mode 
(indicated by the SETUP legend). 

3. Scroll through the menu options until CNF is displayed, then 
simultaneously press both arrow keys. 

4. Scroll through the menu options until UNITS is displayed, then 
simultaneously press both arrow keys. 

5. Scroll through the menu options until M is displayed, then 
simultaneously press both arrow keys. 

6. Scroll through the menu options until END is displayed, then 
simultaneously press both arrow keys. 

7. Simultaneously press both arrow keys to reenter the SETUP mode. 

8. Scroll through the menu options until CAL is displayed, then 
simultaneously press both arrow keys. 

9. Scroll until IN is displayed, then simultaneously press both arrow 
keys. 
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10. Scroll until ZERO is displayed, then simultaneously press both 
arrow keys. 

11. Using the input source, apply an input of 0.000 mV.  Press the arrow 
keys until 0.000 is displayed, then simultaneously press both arrow 
keys to store this zero value. 

12. Scroll until SPAN is displayed, then simultaneously press both 
arrow keys. 

13. Using the input source, apply an input of 99.000 mV (or close to 100 
mV).  Press the arrow keys until 99.000 is displayed, then 
simultaneously press both arrow keys to store this span value. 

14. Scroll through the menu options until END is displayed, then 
simultaneously press both arrow keys. 

NOTE 

 

No calibration changes will be saved until END is selected.  If END is 
not selected, the transmitter will revert to the previous calibration 
status after 75 seconds of inactivity. 

 

15. When DONE is displayed, the millivolt input calibration is 
complete. 
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PLUS

Figure 3.4 Typical Pushbutton Calibration Configuration 

 

NOTE 

 

A Model 1091Plus or equivalent may be used for most field calibration 
purposes; however, to duplicate factory calibration, a DVM and mV 
source of suitable accuracy must be used. 

 

10476a 
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3.3.2.2 Thermocouple Input Calibration 
1. Perform the millivolt input calibration procedure described in 

Section 3.3.2.1. 

2. Simultaneously press both arrow keys to enter the SETUP mode 
(indicated by the SETUP legend). 

3. Scroll through the menu options until CNF is displayed, then 
simultaneously press both arrow keys. 

4. Scroll through the menu options until UNITS is displayed, then 
simultaneously press both arrow keys. 

5. Scroll through the menu options until °C is displayed, then 
simultaneously press both arrow keys. 

6. Scroll through the menu options until CLASS is displayed, then 
simultaneously press both arrow keys. 

7. Scroll through the menu options until J is displayed, then 
simultaneously press both arrow keys. 

8. Scroll through the menu options until END is displayed, then 
simultaneously press both arrow keys. 

9. Simultaneously press both arrow keys to reenter the SETUP mode. 

10. Scroll through the menu options until CAL is displayed, then 
simultaneously press both arrow keys. 

11. Scroll until IN is displayed, then simultaneously press both arrow 
keys. 

12. Scroll until ZERO is displayed, then simultaneously press both 
arrow keys. 

13. Using a precision temperature source, apply an input of 0°C.  Press 
the arrow keys until 0.0 is displayed, then simultaneously press both 
arrow keys to store this zero value. 

14. When SPAN is displayed, simultaneously press both arrow keys 
twice.  IN should be displayed. 



Transmation 2000 Series Universal Temperature Transmitters 
User’s Guide and Reference Manual 

3-22     CONFIGURATION / CALIBRATION Rev. 0803 

15. Scroll through the menu options until END is displayed, then 
simultaneously press both arrow keys. 

NOTE 

 

No calibration changes will be saved until END is selected.  If END is 
not selected, the transmitter will revert to the previous calibration 
status after 75 seconds of inactivity. 

 

16. When DONE is displayed, the thermocouple input calibration is 
complete. 

3.3.2.3 Ohm Input Calibration 
1. Simultaneously press both arrow keys to enter the SETUP mode 

(indicated by the SETUP legend). 

2. Scroll through the menu options until CNF is displayed, then 
simultaneously press both arrow keys. 

3. Scroll through the menu options until UNITS is displayed, then 
simultaneously press both arrow keys. 

4. Scroll through the menu options until Ω is displayed, then 
simultaneously press both arrow keys. 

5. Scroll through the menu options until END is displayed, then 
simultaneously press both arrow keys. 

6. Simultaneously press both arrow keys to reenter the SETUP mode. 

7. Scroll through the menu options until CAL is displayed, then 
simultaneously press both arrow keys. 

8. Scroll until IN is displayed, then simultaneously press both arrow 
keys. 

9. Scroll until ZERO is displayed, then simultaneously press both 
arrow keys. 

10. Using a precision input source, apply an input of 5.00Ω (or close to 
0Ω).  Press the arrow keys until 5.00 is displayed, then 
simultaneously press both arrow keys to store this zero value. 
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11. Scroll until SPAN is displayed, then simultaneously press both 
arrow keys. 

12. Using the precision input source, apply an input of 990.00Ω (or 
close to 1000Ω).  Press the arrow keys until 990.00 is displayed, 
then simultaneously press both arrow keys to store this span value. 

13. Scroll through the menu options until END is displayed, then 
simultaneously press both arrow keys. 

NOTE 

 

No calibration changes will be saved until END is selected.  If END is 
not selected, the transmitter will revert to the previous calibration 
status after 75 seconds of inactivity. 

 

14. When DONE is displayed, the ohm input calibration is complete. 

3.3.2.4 Output Calibration 
1. Connect a precision measuring device of suitable accuracy to the 

transmitter output terminals (a typical calibration connection is 
illustrated in Figure 3.4 on page 3-20). 

2. Simultaneously press both arrow keys to enter the SETUP mode 
(indicated by the SETUP legend). 

3. Scroll through the menu options until CAL is displayed, then 
simultaneously press both arrow keys. 

4. Scroll through the menu options until OUT is displayed, then 
simultaneously press both arrow keys. 

5. 4.000 will be displayed.  Press the arrow keys to adjust the 
transmitter output current until 4.000 mA is indicated on the 
measuring device.  Simultaneously press both arrow keys to store 
this value. 



Transmation 2000 Series Universal Temperature Transmitters 
User’s Guide and Reference Manual 

3-24     CONFIGURATION / CALIBRATION Rev. 0803 

6. 20.000 will be displayed.  Press the arrow keys to adjust the 
transmitter output current until 20.000 mA is indicated on the 
measuring device.  Simultaneously press both arrow keys to store 
this value. 

7. Scroll through the menu options until END is displayed, then 
simultaneously press both arrow keys. 

NOTE 

 

No calibration changes will be saved until END is selected.  If END is 
not selected, the transmitter will revert to the previous calibration 
status after 75 seconds of inactivity. 

 

8. When DONE is displayed, the output calibration is complete. 

3.3.3 Model 2800T and 2900T Diagnostic Prompts 
The Model 2800T and 2900T transmitters also provide self-diagnostic 
prompts for common error conditions.  Prompts such as underrange 
(UNDER), overrange (OVER), or open inputs (OPEN) indicate that an 
input wiring error exists.  Cold junction (CJERR) and reference 
(ERREF) error prompts indicate that a transmitter malfunction has 
occurred; consult the Factory. 
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3.4 HART® PROTOCOL CONFIGURATION / 
CALIBRATION (MODEL 2850T, 2950T) 

The HART protocol permits remote configuration or calibration of a 
Model 2950T transmitter. 

The user interface is described in Section 3.2.  The only significant 
difference is that a HART modem is required and the RS-232 
connection must be configured via the supplied configuration software 
to support the HART protocol.  A typical PC-based connection using the 
HART modem is illustrated in Figure 3.5 on page 3-26. 

The configuration software has the following requirements: 

• Only one transmitter can be present in the loop. 

• The PC running the configuration software must be the only master. 

• The configuration software communicates with transmitters that 
have a HART polling address of 0. 

• A HART modem is required to communicate with the transmitter.  
(A SMAR Model HI 311 modem is recommended; refer to Section 
1.3 on page 1-7 for ordering information).  A typical connection 
using the HART modem is illustrated in Figure 3.5 on page 3-26. 

• The HART protocol requires a minimum loop resistance of 250 
ohms. 

 

A Universal Hand-Held Communicator is required to change the HART 
protocol parameters.  A typical HART protocol connection is illustrated 
in Figure 3.6 on page 3-27. 
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Figure 3.5 Typical PC-Based Calibration Connection 
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Figure 3.6 Typical HART® Protocol Connection 
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4. FACTORY 
SERVICE AND 
WARRANTY 

4.1 FACTORY SERVICE 
Should service become necessary, the instrument should be returned to 
the nearest service facility for repair or replacement.  Please assist our 
service department by defining the symptoms precisely. 

For technical help, contact: 
PYRAGON, INC. 

95 Mt. Read Blvd., #149 
Rochester, NY 14611 

Tel: 800-688-6551 or 585-697-0444 
Fax 585-697-0445 

Email: Help@pyragon.com 
 

4.2 FIVE YEAR WARRANTY 
The Company warrants all equipment manufactured by it and bearing its 
nameplate and all repairs made by the Company to be free from defects 
in material or workmanship under normal use and service for a period of 
five years from the date of delivery to the Purchaser.  Expendable items 
such as fuses, batteries, test leads, and carrying cases are not warranted.  
The Company will repair, at its option, without charge, F.O.B. the 
Company’s factory, any equipment or part thereof found to be defective 
in material or workmanship if such item is returned to the Company’s 
factory, transportation postpaid. 

SECTION 
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4.2.1 Limitation of Warranty and Liability 
The liability of the Company (except as to title) shall in no case exceed 
the cost of correcting defects in products and shall not extend beyond 
five years from date of delivery.  All claims for defective products or 
parts under this warranty must be made in writing immediately upon 
discovery.  The Company assumes no liability for the consequences of 
misuse of products by the Purchaser. 

The foregoing is expressly in lieu of all other warranties whatsoever, 
express, implied, or statutory, including without limitation the implied 
warranties of merchantability and fitness for purpose.  Any references 
by the Company to Purchaser’s specifications and similar requirements 
is only to describe products, and no representation or other terms therein 
shall have any force or effect.  Catalogs, circulars, and similar literature 
of the Company are issued for general information purposes only and 
shall not be deemed to modify the provision hereof. 

The foregoing is the Company’s only obligation and the Purchaser’s 
only remedy for breach of warranty; and except for gross negligence, 
willful misconduct, and remedies permitted under any other clause of 
these Terms and Conditions, the foregoing is the Purchaser’s only 
remedy hereunder by way of breach of contract, negligence or 
otherwise.  In no event shall the Purchaser be entitled to incidental, 
special, or consequential damages.  The Company does not authorize 
any agent or representative to warrant product fitness for any particular 
use or to make any other warranty, express or implied, or to assume any 
other liability, except as set forth herein. 

4.2.2 Discrepancies in Shipment and Damage to 
Merchandise 

Products manufactured by the Company are carefully packed and 
thoroughly inspected before leaving the Company’s factory.  Any claim 
for discrepancies will be honored only if reported within 15 days from 
receipt of shipment. 
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Responsibility for safe delivery of products is assumed by the carrier 
upon acceptance of the shipment.  Consequently, claims for loss or 
damage sustained in transit must be filed with the carrier as follows: 
Written requests for inspection by the carrier’s agent should be made 
within 15 days of the delivery date when concealed loss or damage is 
discovered.  Concealed loss or damage means loss or damage which is 
not apparent until merchandise is unpacked; contents may be damaged 
in transit due to rough handling even though packaging may not show 
external damage.  As to visible loss or damage, any external evidence of 
loss or damage must be noted on the freight bill or express receipt, and 
such document should be signed by the carrier’s agent at the time of 
delivery.  The Purchaser’s failure to adequately describe such external 
evidence of loss or damage may result in the carrier’s refusing to honor 
a damage claim.  The carrier will supply a form for filing such a claim. 

4.2.3 Miscellaneous 
This Agreement shall be construed and interpreted under the laws of the 
State of New York.  The parties hereby consent to the jurisdiction of the 
courts of the State of New York and agree that venue shall lie in Monroe 
County.  The invalidity in whole or in part of any provision hereof shall 
not affect the validity of any other provision. 

 

 



 

 
 
 

95 Mount Read Blvd., #149 
Rochester, NY 14611 USA 

Phone: 1.800.688.6551 • 1.585.697.0444 
Fax: 1.585.697.0445 • Email: sales@pyragon.com 

 

 


